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Before You Install

This is your January 1, 2011, tax update for Sage Accpac U.S. Payroll. This document describes important
changes that affect your payroll system.

If you receive the tax update on CD, note that the CD contains versions 5.4P, 5.5K, 5.6G, and 6.0B. Install
the version that is compatible with your version of Sage Accpac U.S. Payroll.

Note: To install the tax update follow the instructions on the CD or as described in “How do I install
the tax update?” on page 3.

Important Notice for Customers using Sage ERP Accpac Version 5.4 with Payroll
Tax Table Updates

January 2011 will be the FINAL TAX UPDATE

Earlier this year, Sage notified all Payroll Update Plan (PUP) subscribers that after the 2010 tax year,
Sage ERP Accpac Version 5.4 will no longer be supported. This change is particularly important because
it means no additional tax updates will be made available after the 2010 tax year. You will need to ensure
that your PUP subscription is current to continue receiving compatible updates and upgrade to Version
5.5 or higher.

The last Sage ERP Accpac 5.4 Payroll Tax Update for US Payroll will be January 1, 2011. Based on
recent customer feedback, this particular update is a full update that includes updated forms as well as
tax table changes provided for 2010 tax filing.

There will NOT be a 5.4 Payroll Tax Table Update for March 2011 or going forward.

Before You Install

Note: Before installing the Service Pack/Product Update or the Tax Update, make sure all users have
exited the program and there are no Sage ERP Accpac instances running.

Important Update—Installation Process Change

Activation Codes are no longer required. This modification to the installation process requires some
additional requirements. Please ensure you update your installation process appropriately.

Critical - Product Update Requirements

Before installing the payroll tax update, you must verify your service pack or product update level
first. More details on the error you will receive if you are not running the correct Product Update for
your version can be found in the Answer ID 28923 Knowledge Base article. To verify what service
pack or product update you have installed, click the System Information option in the Help menu in

your Sage ERP Accpac program.
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About this Update

e If you are on Payroll 5.4A, System Manager Service Pack 3 or higher is required.
e If you are on Payroll 5.5A, System Manager Product Update 3 or higher is required.

e If you are on Payroll 5.6A, it is recommended that you install Product Update 1 before
installing the Tax Update.

e If you are on Payroll 6.0A, no update is required.

To download Service Packs or Product Updates, follow the steps below:

1. Log on to the Sage Partner Portal.

2. Click here to access the Product Update page.

About this Update

You need the January 1, 2011, tax update to produce your forms for year 2010, and to process your
payroll in 2011.

Why did | receive a tax update?

This tax update contains specifications that allow you to produce W-2 forms for 2010 on paper, on
diskette, on CD, or on hard disk. It also contains changes for federal and state (or local) income tax for
the year 2011. You need this tax update to produce W-2s for 2010 and to process payroll using the tax
changes for 2011.

When do | install the tax update?

Install and activate the January 1, 2011, tax update immediately. (You can install now even if you still
have payrolls to process for 2010. The program uses the processing dates to select the correct tax
calculations.)

You must install and activate the January 1, 2011, tax update before you produce W-2s for 2010 or
process payrolls for 2011.

When do | close the year?

You never close the year. Simply continue processing payrolls as you do all year long, entering
period-end dates in the new year as you cross the calendar year boundary.

After you have completed all the previous year’s year-end processing (W-2s, final 941, reports), and
made backup copies of the data, you can run Delete Inactive Records to remove terminated
employees and other obsolete information from your data.
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About this Update

Can | produce W-2s for 2010 after processing payrolls for 2011?

Yes. The U.S. Payroll program allows you to start processing payrolls for a new year and later

produce W-2s for the previous year without any extra procedures. When you produce W-2s, select
2010 as the Payment Year.

How do | install the tax update?

If you are downloading the tax update from our Web site, follow the installation instructions on the
Web site. If you need more information, see the next topic “Installation Windows”.

If you receive the tax update on CD, please follow the below instructions to start installation:

1.

2.

Log on to Windows.

It is recommended that you back up your data.

Insert the tax update CD in your computer’s CD drive.
Explore to your CD Drive.

Double-click on the version folder that you want to install; for example, to install version 5.5,
double-click on UT55K, and then double click on SAEUT55K .exe.

Follow the instructions on your screen.

Installation Windows
After you have started the first Installation window, follow these steps.
1. On the Welcome screen, click Next to continue to the Software License Agreement screen.
2. Follow the instructions on the screens that follow. For example, you will need to specify:

e  Where you want to install the tax update (accept the default directory, or type another
path, or click the Browse button to select the path to the drive and directory where you
installed Sage Accpac U.S. Payroll).

e The components to install. Be sure to select the tax update program files and
documentation.

e The appropriate folder in which to install the program icons.
3. On the Start Copying Files window, choose Next to continue.

4. On the Setup Complete window, select to view the Readme file to review the Payroll tax
changes and adjustments you may need to make to your payroll records. Click Finish to
finish the installation and view the Readme file.

5. Close the Readme file and exit the Installation screen.

Tax Update 3



About this Update

Activate the January 1, 2011, tax update as described in the next section “How do I activate the
tax update?

How do | activate the tax update?
1. Back up your data, if you have not yet done so.
2. Start Sage ERP Accpac and open the Administrative Services folder.
3. Activate your data as follows:
a. Choose Data Activation.

b. Highlight US PR Tax Update January 1, 2011 5.xx, where xx is the tax update version
compatible with your Payroll version.

Note: If you are using Payroll version 6.0, highlight US PR Tax Update January 1, 2011
6.xx.

c. Click Activate.

4. 1If you are prompted to convert a previous U.S. Payroll tax update to the current version, click
Proceed.

After you have completed installation and activation, and made any necessary adjustments described
in this document, you can resume processing payrolls.
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What’s New in this Tax Update

What’s New in this Tax Update

For a description of new features, changes, and adjustments you may need to make, be sure to read the
tax update readme file. You can open the readme by following either of these procedures.

For Sage Accpac versions 5.4 and 5.5:

e In Microsoft Windows, click the Start button; then choose All Programs > Sage Accpac (or
ACCPAQ) > Online Documentation > US Payroll Tax Update 5.5K or 5.4P > Readme.

Or

e Open the Sage ERP Accpac desktop and select the Help menu, then Online Documentation > US
Payroll Tax Update 5.5K or 5.4P > Readme.

For Sage Accpac version 5.6 and 6.0:

e In Microsoft Windows, click the Start button; then choose All Programs > Sage Accpac >
Documentation.

Or
e  Open the Sage ERP Accpac desktop and select the Help menu, then Documentation.

The readme is UTmmddyy Readme.wri.

Advance earned income credit (EIC)

The advanced earned income credit allowed qualified individuals to receive part of the credit in each
paycheck during the year the taxpayer expects to qualify for the credit. This credit will be eliminated,
effective January 1, 2011.

Important! To ensure that the Advanced EIC no longer accumulates, you must remove the
USEIC code from all applicable employees after you run your last payroll for 2010 and before you
run the first payroll for 2011.
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What’s New in this Tax Update

To remove the USEIC code, do the following:

1. Determine which employees have the USEIC in their profile by printing the Payroll Tax
Profiles Report (in the Payroll Setup Reports folder, select Tax Profiles).

= MANTST - Payroll Tax Profiles Report

File Help
Tax Type Federal and State Taxes hd
Report Format Employee Listing b
From To
Tax Code USEIC Q, Useld Q
Employes Mumber Q ST Q
Sedection List Q

2. Using this report, on the Employee Payroll window (in the Payroll Employees folder, select
Employees > select the employee > Taxes tab), remove the USEIC from each of the
employees.

2R JMANTST - Payroll Employee
File Help

Emplayes TR BE] b oM QLD [KANSAS M3

Generel| Class/Schd| Py Tawes | Oter | gl Fieks | EFT |

QA Tax [lescrphon ‘withholdng Method Amount/FPecent Exra'wiH K Q G/L D™
KS51T Kansas Income Tax Standard Calculation 0on 1

KS5UTA Kanzaz Unemployment Tax Standard Calculation 0.0 1
USEIC PR 2T el Standerd Calculation | ool |
USFIT LS Federsl Income Tax Stardard Calculation 000 1

LSFUTA LS Fedesal Unemployment . Standard Calculation 0o 1

USMED Madcars Tax Standard Calculation [

U555 Social Security Tax Standard Calculation 00a 1

w

£ ¥
Inlammation

For addtional tax details, highlight a tax in the gid and click the Tax info button

[ sae | [ Deler | [ Taxiie. | Dlose

3. To remove the code, highlight the tax line and press Delete on your keyboard.
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Common Year-End Questions

Common Year-End Questions

Which W-2 printed formats can | use?

Sage Accpac U.S. Payroll prints W-2s in these formats:
e 2-per-page laser printer forms

e 4-per-page condensed laser printer forms

e 2-per-page dot-matrix printer (tractor-feed) forms

If the printer jams or goes offline while printing W-2s, how do | get the printer
to begin printing where it left off?

From the Government Reports folder, select W-2s On Paper, and then enter the range of employees
that have not yet been printed.

Note: Although you can print W-2s selectively this way, you will not get the correct totals
needed for the W-3 form. To get the correct totals (that is, the totals of all W-2s), you must reprint
all the W-2s (not just the range of W-2s that did not print). To save paper, you can reprint all the
W-2s on your screen or to a file instead of on paper.

Is there a limit to the number of times the W-2s can be printed?

You can print the W-2 forms as many times as you need to.

How does the W-2s On Disk(ette) function work?

The W-2s On Disk(ette) function writes W-2 information to a file on diskette(s), or on your hard disk,
depending on your choice.

Note that the Social Security Administration (55A) does not accept W-2s on physical media (such as
diskettes or CD).

You then electronically submit the W-2 file from your hard disk to the SSA. Or, for states that still
accept W-2s on diskette, you submit the diskettes to the state taxing authority.

This function is similar to the W-2s On Paper function.

For more information, see the next section, “Reporting W-2s for 2010 on Diskette or by Electronic
Filing.”
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Reporting W-2s for 2010 on Diskette or by Electronic Filing

Reporting W-2s for 2010 on Diskette or by Electronic Filing

As of tax year 2006, the Social Security Administration (SSA) no longer accepts W-2s on physical media
(such as diskettes or CD), although some states still do. For more details about the submission methods
that are acceptable for W-2 reporting and submission deadlines, consult your tax authorities.

Before reporting W-2 data on diskette or electronically, read the federal or state publications on magnetic
media so you are familiar with all the requirements. Some may vary from year to year. Be sure to enter all
amounts in the formats specified by the federal or state instructions.

Payroll enables you to create W-2s to a file on diskette or on your hard disk.

Creating the W-2s to a file on your hard disk enables you to electronically submit the file, primarily
intended for federal W-2 electronic filing. However, you can use the hard disk method for state electronic
filing, if:

e Payroll supports this method for your state. To see which states are supported, see the later section
“Report Format for Diskette or Electronic Filing.”

and

e Your state allows electronic filing. Check with your state’s Department of Revenue before producing
the W-2s.

It is very important that you back up your data that you used to create the W-2 data file. In the event that
the SSA (or your state taxing authority) cannot read or process your W-2 data file, you may need to
recreate the file using the data from your backup.

We strongly recommend that you retain a copy of the files you send.

We also recommend that you test the W-2 data file(s) before submitting them by using the SSA’s
AccuWage software. See step 6 of the instructions “How to Create W-2s on Diskette or Hard Disk” on
page 10.

Report Format for Diskette or Electronic Filing

Sage Accpac U.S. Payroll supports the federal disk format specified in the Social Security
Administration’s EFW2 document, Specifications for Filing Forms W-2 Electronically (EFW2).
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Reporting W-2s for 2010 on Diskette or by Electronic Filing

For state reporting;:

Sage Accpac U.S. Payroll will produce a W-2 file in the federal EFW2 format (formerly MMREF-
1), with slight variations if required by the state, for the following states:

Alabama Michigan
Arizona Minnesota
Arkansas Mississippi
Colorado Missouri
Connecticut Nebraska
Delaware North Dakota
Georgia Ohio

Idaho Oregon
Nlinois Pennsylvania
Indiana Rhode Island
Kansas South Carolina
Kentucky Utah
Louisiana Virginia
Maine West Virginia
Maryland Wisconsin
Massachusetts

For all other states not listed, U.S. Payroll will produce a W-2 file in the federal EFW2 format,
with no variations.

For diskette reporting for California and New York, please refer to the PDF-formatted document
QW on Diskette 6.0B (5.6G, 5.5K, or 5.4P) that is included with this tax update. To obtain this
document, see “Quarterly Wage Reporting on Disk(ette)” on page 8.

U.S. Payroll also enables Puerto Rico employers to report W-2s on diskette, in the format required
by the Puerto Rico Department of the Treasury.

U.S. Payroll does not support:
e The federal tape format for any state.
e Annual reporting for the U.S. territories (except Puerto Rico).

If you are required to file 250 or more W-2 forms, you must submit W-2s electronically for federal
reporting, unless the IRS grants you a waiver. The number of employees at which state diskette
reporting becomes necessary can vary.
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Reporting W-2s for 2010 on Diskette or by Electronic Filing

How to Create W-2s on Diskette or Hard Disk

You can create W-2s to a file on diskette, or on hard disk for electronic submission.

Note: Creating the W-2s to a file on your hard disk is primarily intended for federal W-2
electronic filing. If you wish to create it for state electronic filing, check first with your state’s
Department of Revenue to see if electronic filing is acceptable. Also, check if your state is
supported by Sage Accpac U.S. Payroll, as described in the section “Report Format for Diskette
or Electronic Filing,” on page 8.

To create W-2s on diskette or on hard disk, follow these steps:
1. From the Payroll Government Reports folder, select W-2s On Disk(ette).

2. The choices at the Tax Authority field are the income taxes that you have set up in Federal and
State Taxes. In the Tax Authority field:

e Select US Federal Income Tax to prepare a W-2 data file for federal reporting.
or

e Select your state to prepare a W-2 data file that includes only employees with data for your
state.

3. Complete the information on the Payroll W-2s On Disk(ette) form, using your government
publication as a guide.

4. After you enter all the fields, click Process.

5. On the dialog box (called W-2 Report File Destination) that appears, select either Diskette
Submissions or Electronic File Upload, and follow the instructions on the dialog box.

a. If you selected Electronic File Upload, you must enter the hard disk location where you want
your W-2 data file to be produced.

b. Click OK.

The system will automatically create a W2REPORT data file.

Note: For some states, the system will create a file with a different name, to meet
government requirements.

6. Before you submit the W-2 data file, you can test it by using AccuWage, a software application
that you can download from the SSA’s Web site:

http://www.socialsecurity.gov/emplover/accuwage/

Note: AccuWage is only for the federal EFW2 (formerly MMREEF-1) reporting purposes.
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Reporting W-2s for 2010 on Diskette or by Electronic Filing

Read the information on the Web site before downloading and using AccuWage. AccuWWage
checks the W-2 data file for the most common errors.

After you start AccuWage (and insert the diskette into the drive, if the file is on diskette), click
Start Testing. A dialog box then asks you to enter the file name to be tested. In the Files Of Type
field, be sure to select All Files {*.*} Then double-click the file name to start the testing. When
testing completes, you will be informed of any errors found.

7. Make a backup of your company data files. If the Social Security Administration (or state) cannot
read or process the W-2 data file you submit, it may be necessary for you to re-create the file.

8. When you are ready, follow the instructions from the Social Security Administration (or state) to
submit the W-2 data file on diskettes or electronically. (If you need information regarding
multiple diskettes, see the next section “Multivolume Reporting on Diskette.”)

Retain a copy of the W-2 data files you submit to federal and state tax authorities for your
records.

Multivolume Reporting on Diskette

Payroll supports multivolume reporting for the states that accept W-2s on diskette. When data in the
W2REPORT file fills one diskette, the system prompts for another diskette. The file name on both (or
more) diskettes is W2REPORT.

If your state requires that W2REPORT have a file name extension for multivolume reporting, use the
RENAME function (on the File menu in Windows Explorer) to rename the W2REPORT file on each
diskette.

If a state requires a file name extension for multivolume (multiple-diskette) reporting, rename the
W2REPORT file on the diskette in drive A to:

w2report.d01 (where d01 is the first, d02 the second, d03 the third, and so on, of multiple
diskettes).

The approximate number of employees* per diskette for magnetic media reporting in the federal
EFW?2 format (formerly MMREEF-1) is as follows:

Diskette Number of Employees *
720K 470
1.44M 940

The numbers assume that each employee is configured for one state.
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Reporting W-2s for 2010 on Diskette or by Electronic Filing

Additional Instructions for Specific States (W-2s on Diskette or Electronic Filing)

This section provides additional instructions for specific states that are filing W-2s electronically or on
diskette. Additional information for states may also be provided in the readme file that is included
with this tax update.

Kentucky Requirements

In Federal and State Taxes, remove the hyphen and check digit from the Kentucky Tax Reporting
ID (Employer Identification Number). For example, change the ID 123456-7 to 123456.

Maine Requirements

Support is now included to report up to 5 MEPERS (Maine Public Employee Retirement System
Contributions) codes. Verify that the W2 reporting for the deduction setup is set to “Other
Information Box”. Add the codes in the Employer Info II tab.

Ohio Requirements

Support is now included to report up to 5 School District wages and taxes under the Supplemental
Information setup under Employees. If you have at least one school district for an employee, then
the first set of boxes cannot be blank.

For the particular employee, define the school district to which you want to report (4 digit school
district code) in the first box. In the next box, enter the tax code you setup in Local and Customs
Taxes for this school district. You can enter up to 5 school districts for a single employee.

On the Employee tab of the Employee Supplemental Information window, if you enter a School
District code you must enter a Local tax ID code.

Wisconsin Requirements

In Federal and State Taxes, remove the hyphen and check digit from the Wisconsin Tax
Reporting ID (Employer Identification Number). For example, change the ID 123456-7 to 123456.

Virginia
Only the Web Upload specification is supported.

Maryland Requirements

Before you create your W-2 on diskette, you need to set up so that the local/county tax and the
state tax are reported as one amount. To do this:

1. From the Payroll Setup folder, open the Local and Other Custom Taxes form, and select your
local/county tax (such as M1).

2. On the Employee tab, in the W-2 Reporting field, choose Combine With Another Tax.
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Reporting W-2s for 2010 on Diskette or by Electronic Filing

3. Inthe Combine With Tax field, choose MDSIT.

4. After your diskette is created, restore the original setting.

Indiana Requirements

If you are reporting more than 2000 W2’s, use the From Employee/To Employee range option to
create the multiple W-2s on Disk(ette). The EFW2 format for Indiana will only support up to
approximately 2000 W2s in a single file.

In order to have U.S. Payroll generate Indiana county tax information on the W-2 data file, read
this section.

Check the Reporting ID
Before you create the W-2 data file, check that the reporting ID is properly configured, as follows:
1. On the Federal And State Taxes setup form, choose INSIT.

2. In the Reporting ID field, check that the first 10 digits signify the Employer TID (Taxpayer
ID) number, and the next 3 digits signify the Employer TID location.

Enter Employee Supplemental Information

Before you use the W-2 On Disk(ette) form to create your W-2 data file, use the Employee
Supplemental Information form in the Employees folder to enter the values in the County Tax ID
and County Code fields on the Defaults tab. If you need more details, press F1 on the W-2 On
Disk(ette) form to view the online Help.

Miscellaneous Information for W-2 Diskette and Electronic Reporting

The following miscellaneous information is of interest to you if you report W-2s on diskette or
electronically.

Filing Deadlines. W-2s filing deadlines vary, depending on the submission method you use, or
your state. Contact your tax authorities for more information.

Second EIN. For federal reporting, you can enter a second EIN for the Employer Record Data at
the Other EIN field.

Employee Addresses. When creating W-2s on disk, the Payroll program takes line 1 of the
Address field of the Employees form as the Delivery Address, and line 2 of the Address field as
the Location Address. Therefore, enter the street or post office in line 1 of the Address field, and
the suite and room number in line 2 of the Address field if applicable.

State/Province field. Enter the state abbreviation in the State/Prov. field if the employee’s address
is in the USA.
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Reporting W-2s for 2010 on Paper

e Foreign addresses. The U.S. Payroll program supports foreign addresses for employees. EFW2
(formerly MMREF-1) requires the country code in a foreign address.

If an employee’s Country field is not USA (the default), the Payroll program assumes the employee
has a foreign address. Then, in the W2REPORT file, the program reports the country code entered in
the Country Code field of the Employees form.

Reporting W-2s for 2010 on Paper

To print W-2s on paper, use the W-2s On Paper online form, which you open from the Government
Reports folder in U.S. Payroll.
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